
Brings the one-click convenience of toolbars to
QuarkXPress. Create your own custom toolbars
or let QX-Smart Bars build them for you.

To create your own toolbar:
1. Choose Edit Toolbars from the Edit menu.

All available toolbars are displayed. Click in
the checkmark column to hide or display
toolbars.

2. Click the New... button.
An untitled toolbar appears on your desktop.

3. Click the Customize button.
4. Choose a Category.
5. Drag a button from the Category field to a

toolbar. To delete buttons, simply drag buttons
off the toolbar onto the desktop.

To use Smart Bar:
1. Choose QX-Smart Bar from the View menu.

Smart Bar begins watching you work and
creates buttons by recording your menu
selections.
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A The Categories field displays a list of
available categories. Each category
contains its own set of buttons. For
example, the Style category displays
buttons that represent the commands
from the QuarkXPress Style menu.

B The Description field displays a
description of any button in the
Categories field. Simply hold your
pointer over a button to read a
description of the button.
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Introducing QX-Tools 2.0. This collection includes 15 of the most
powerful and useful XTensions that let you work faster, easier and more
efficiently in QuarkXPress.®

FIVE NEW REASONS YOU CAN’T LIVE WITHOUT QX-TOOLS!
We’ve added five all new XTensions to the original 10 XTensions that
made QX-Tools the bestselling XTension package for QuarkXPress.
With QX-Tools 2.0 you can interactively set paragraph rules, create and
save custom New Document settings and create drop shadows, glows,
bevels, and more! In addition, QX-Tools offers the ability to copy styles
and conduct document-wide search and replace for objects.

MORE TOOLS THAN YOU CAN SHAKE A T-SQUARE AT.
QX-Tools includes QX-Smart Bar, so you can create your own
customizable toolbars or let QX-Smart Bar build them for you.
You can scale multiple objects simultaneously and create and work in
layers like with Illustrator and Photoshop. You can also run your favorite
Photoshop compatible plug-ins right inside QuarkXPress and save an
object or region of your page as an EPS file. And you get a daily tip or
trick from David Blatner, coauthor of The QuarkXPress Book.
The QX-Tools XTensions are designed, tested, and guaranteed to work
together. To order, or for more information on any of our award-winning
products, simply call us at 1-800-796-9798.

Visually and interactively create drop shadows,
glows, bevels and embosses from type, pictures,
boxes or lines directly within QuarkXPress.

To create an effect:
1. Select an image or object.
2. Choose QX-Effects from the Utilities menu.

The QX-Effects palette appears. Use the pop-up
menus to establish settings for the effect.

3. Click the tab for the effect you want to create.
4. Click the Create Effect button.
5. Use the options in the effect’s dialog box to

create your desired effect.
6. Click the Apply button.

A The Apply Current Effect button applies the
currently selected filter to the selected item.

B The Create Effect button displays the dialog
box for the currently selected effect.

C Defines what part of the image the effect
considers the edge.

D The TIFF Resolution menu lets you set the
resolution of the resulting TIFF image.

E The TIFF Info menu allows you to view
information about the selected TIFF image.

F The Image File Type menu displays the
final TIFF image format (RGB, CMYK, etc.)

G The Preferences button displays the
Preferences dialog box.

H The QX-Effects tabs establish which effect
you’ll apply to the selected item.

I The Saved Effects menu contains sets of
effects you’ve previously saved.

J The Information area displays the current
filter settings.
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C The Buttons field displays buttons for
the currently selected category.
Buttons can be dragged from the
Buttons field and added to any new or
existing toolbars.

D The New button displays the Edit
Custom Button dialog box. You can
create new buttons to access
keystroke commands, menu items,
and finder items.

QX-SmartBar automates the
task of creating buttons and
toolbars by watching and
recording your menu selections.
Just turn on SmartBar by
clicking the “Watch Me” button
and SmartBar creates a
corresponding list of buttons.
To convert a list of SmartBar
buttons into a toolbar, just click
the “Build Toolbar”  button.
Then, instead of searching for a
command in a menu, you can
simply click a toolbar button.



Apply your favorite Photoshop-compatible
plug-in filters to images within QuarkXPress.

To filter images:
1. Choose QX-Filters from the Utilities menu.
2. Select the image to be filtered.

QX-Filters can apply filters to gray scale, RGB,
CMYK, PICT or TIFF images.

3. Choose an Image filter from the Filter pop-up
menu.
After the filter has been applied to the image, a
new file with a version number will be created
in the same folder as the original image file.
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A The QX-Filters toolbar enables you to move
between filtered images, delete unwanted
images and offers masking and preferences
options.

B The Acquire pop-up menu displays Acquire
plug-ins used for importing an image
through a scanner, video digitizer or other
output device.

C The Current Filter field displays the name of
the filter used.

D The Current File field displays the file name
of the selected image.

E The Command pop-up menu offers menu
access to the same commands in the
toolbar. In addition, options for customizing
the palette size are also available.

F The Filter pop-up menu displays filters.
Choose from several Extensis filters or any
Photoshop compatible filters you have
installed.

QX-FILTERS
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Offers a direct and easy way to interactively
edit paragraphs, boxes, text, paragraph rules
and objects.

To use the QX-FineTune panels:
1. Depending upon the attributes you wish to edit,

choose one of the following;
Paragraph: Use your mouse to highlight one
or more paragraphs.
Character:  Select a character or block of text.
Object: Select a picture or text box.
Rule: Select a paragraph or add an insertion
point and change the thickness of the rule to
greater than zero.

2. Choose Show QX-FineTune in the View menu
then click the appropriate tab.

3. Determine the attribute you want to change
then click its up or down arrow.

A Each of the four QX-FineTune palettes
function similarly. Rule is shown here as an
example. Modifying an attribute is as simple
as clicking the up or down arrow or entering
a value in a text field and pressing Return
or Enter.

B The left-most column displays a graphical
representation of a specific attribute.

C The up and down arrows allow you to
increase or decrease an attribute’s value by
clicking the arrow. To multiply the value in a
field by 10, hold down the shift key while
clicking the up or down arrow. For finer
tuning, hold down the Option key while
clicking the up or down arrow to adjust the
value by 1/10 units.

D The text fields provide an alternative
method for adjusting an attribute’s value.
Enter a specific value in the attribute’s text
field and press Return to apply the new
value.
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Enables you to create and save custom New
Document settings. Define document settings
such as page orientation, count and size.

To create a new document style:
1. Open QuarkXPress. Choose New in the File

menu and then choose Document.
The QX-DocStyles dialog replaces the standard
QuarkXPress New Document dialog.

2. Enter the desired settings for this style.
3. Type a name for the new document window in

the Document Name field.
4. Click the New button.

The Save Settings As DocStyle dialog appears.
5. Type a name for this document style.
6. Click the OK button.

The new style’s name appears in the DocStyles
pop-up menu.

7. Click the OK button.

A The DocStyles and Document Name fields
allow you to name and define page size.

B The Document Info settings offer page
count, text box and facing page options.

C The Set Section Start options enable you
to define section parameters such as
starting point, prefix, and format.

QX-DOCSTYLES

D The Page Size options allow you to select
page orientation and set page dimensions.

E The Document Guides settings allow you
to define the margins settings, number of
columns and gutter dimension.

F These buttons offer options to save, rename,
duplicate, delete, and update document styles.
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Offers an indispensable layer manager which
enables you to easily edit objects while keeping
them in the proper stacking order on the page.

To create a new layer:
1. Choose Show QX-Layers from the View menu.
2. Select the items you want to place on a layer.
3. Click the New Layer button on the QX-Layers

toolbar.
4. Enter a name for the new layer and click OK.

To modify the stacking order of layers:
1. Open the QX-Layers palette.
2. Select and drag the layer name to a new

position in the layer list.
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A The Layer field displays the layers in the
document. The listed layer order represents
the stacking order on the page. In this
example, the Standard layer is the top layer
and the Cool layer is the bottom layer.

B The Show/Hide column displays which
layers are visible or hidden. A checkmark in
this column indicates the layers that are
currently displayed.

C The QX-Layers toolbar offers quick
access buttons for modifying layers.

D The Lock/Unlock column displays which
layers are locked or unlocked. A checkmark
indicates a layer is locked.

E The Set pop-up menu displays the available
sets of layers. Multiple layer configurations
can be created, stored, and selected as
needed.

F The Command pop-up menu offers options
for modifying the size of the QX-Layers
palette.

G The Active Layer triangle indicates which
layer the currently selected object is on.

QX-LAYERS
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Instantly copy attributes from objects and text
and apply them to other objects—even groups
of objects—and text.

To use the QX-CopyStyle palette:
1. Choose Show QX-CopyStyle from the View

menu.
2. Click the grow box in the upper-right corner.

An expanded QX-CopyStyle palette appears.
3. Select the attributes of the selected object that

you want to copy.
4. Select the text or object you want to copy and

click the Copy button.
5. Select the text or object you want to attach the

attributes to and click the Apply button.

A The Copy button picks up the style of the
object or text block that you’ve selected.

B The Apply button changes another object or
text block to match the copied style.

C The Undo button reverses the last action.

D The Grow box expands and collapses the
QX-CopyStyle palette.

E Picture Attributes  appears when a
graphic is selected. Changes: scale, angle,
skew, colorization, contrast, and more.
Paragraph Attributes  appears when your
cursor is within a paragraph. Changes:
indents, leading, alignment, and more.
Text Style Attributes  appears if multiple
characters are selected. Changes: font,
size, style, color, shade, scale, and more
Frame Attributes  changes width, color,
shade and style.
Structure Attributes  changes angle, skew,
corner radius, columns, gutter width, text
inset, baseline, alignment and background
color.
Box Color Attributes  changes box color
(shade, color and blend).
Trapping Attributes  changes background
and text behavior.

QX-COPYSTYLE
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Displays a miniature representation of any page
or spread so you can efficiently navigate
through your document.

To open the QX-Viewer palette:
1. Choose Show QX-Viewer from the View menu.

A preview of the current spread is displayed.

To view other pages in your document:
1. Choose the desired page or spread from the

Page pop-up menu.
To move to the displayed page simply click on
the page in the palette. You can also use the
QX-Viewer toolbar buttons to move to the first,
last, next, or previous page in a document.
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A The QX-Viewer window displays a
representation of any page or spread.

B The View pop-up menu enables you to
change the size of the document view.
Choose from viewing levels up to 900% or
create your own.

C The QX-Viewer toolbar offers several
options for quickly moving through a
document. The preferences button
enables you to control the settings that
affect QX-Viewer.

D The Page Number pop-up menu indicates
which page is currently displayed in the
QX-Viewer window. The pop-up menu lists
all the page spreads in the entire document
so you can quickly move to any spread.

E The Command pop-up menu offers menu
access to the same commands in the
toolbar. In addition, options for customizing
the palette size are also available.

F Click and drag the bottom right corner to
resize the QX-Viewer palette.

QX-VIEWER
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Create character-based style sheets and work
with both character styles and paragraph styles
from one convenient palette.

To create a character style sheet:
1. Choose Show QX-Styles from the View menu.

The top half of the QX-Styles palette lists the
character style sheets. The document paragraph
style sheets are listed at the bottom half of the
palette.

2. Click the Add Styles button.
Select the character attributes you want to apply
for this style then click OK.
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A The Paragraph Style Sheet field displays
the available QuarkXPress paragraph-level
style sheets.

B The Character Style Sheet field displays the
QX-Styles character-level style sheets.

C The Set pop-up menu displays the available
sets of character-level style sheets. Multiple
style sheet configurations can be created,
stored, and opened as needed.

D The QX-Styles toolbar enables you to
quickly modify character attributes such as
font, size, and style. The Add Styles and
Edit Styles buttons enable you to quickly
add or edit styles.

E The Command pop-up menu offers menu
access to the QX-Styles toolbar buttons. In
addition, several options are available to
modify the size of the QX-Styles palette to
your preference.

QX-STYLES
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Simplifies the process of loading and unloading
QuarkXPress XTensions. Create sets for
XTensions for specific projects and clients.

To open QX-Manager:
1. Choose QX-Manager from the Utilities menu.

To force QX-Manager to open automatically
before QuarkXPress is launched, simply select
the “Always display upon launching” checkbox
under General Options.

To load and unload XTensions:
1. Open the QX-Manager dialog.

To toggle an XTension on or off, click on or to
the left of the XTension name.
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A The XTension list displays all your
QuarkXPress XTensions. A checkmark
next to an XTension indicates that the
XTension will be loaded.

B The XTension Set pop-up menu displays
sets of XTension selections. Multiple
groups of XTension configurations can
be created, stored, and selected as
needed.

QX-MANAGER
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C The Set Options fields let you change the
amount of RAM allocated to QuarkXPress
and assign a shortcut key for changing
sets when launching QuarkXPress without
going through the dialog box.

D The General Options checkboxes offer
options for launching and incorporating
new XTensions into sets. In addition, you
can choose to have QX-Manager appear
every time before starting QuarkXPress so
you can instantly change sets or make
adjustments to the loading XTensions.

Extends search and replace to include nearly
every type of object, including text and picture
boxes, rules, colors, character, lines and more.

To use any QX-FindChange attribute:
1. Choose QX-FindChange from the Utilities

menu.
2. Click the tab corresponding to the attribute you

want to change.
3. Select the options and provide the information

for the changes.
4. Click the Find First button to locate the first

occurrence matching your search criteria.
Found objects appear selected in the upper left
corner of the document window.

5. Choose the “Change,” “Change, Then Find,” or
“Change All” button.

6. Click the Close box in the upper left corner to
exit the QX-FindChange dialog box.

A The Selection Tabs allow you to
select the attribute you want to
change.

B The Find This area displays
the search criteria for the selected
tab option.

QX-FINDCHANGE

C The Find In feature (only in some
panels) offers an option to apply the
change tothe current text chain or
to the entire document.

D These search buttons offer several
search and replace options.

E The Change To This area indicates
how you want to change the
occurrences that matchyour search
criteria.

F The Close box exits the
QX-FindChange dialog box.
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Displays a graphic representation of your fonts.
Insert characters with a single mouse click
without having to manually change fonts.

To use the QX-Dingbats palette:
1. Choose QX-Dingbats from the Utilities menu.
2. Select a font from the Font pop-up menu.
3. Scroll to find the desired symbol.

You can choose to modify the font size before
inserting a symbol into the text.

4. Click the Insert button or double-click the
symbol.

To add fonts to the Font pop-up menu:
1. Click the Command pop-up menu and select

“Show Full Font List”.
2. Double-click fonts you want to add to the

QX-Dingbat Font pop-up menu.
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A The QX-Dingbats window displays the
special characters available from the
selected font. Use the scroll bar to quickly
view all characters or resize the palette.

B The Insert button inserts the selected
special character into the text or you may
simply double-click on the character.

C The Font pop-up menu displays the current
selection of available fonts.

D The Size pop-up menu lets you specify the
size of the character you want to insert.

E The Command pop-up menu offers the Full
Font List so you can add or remove fonts to
the QX-Dingbats Font pop-up menu.

F The Grow box lets you to resize the palette.

QX-DINGBATS
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Resize any item or group of items such as text,
graphics, and lines in a single step.

To resize selected items:
1. Choose QX-Scaler from the View menu.
2. Select the item(s) to be scaled.
3. Type the desired scaling in the edit boxes.

Any percentage lower or higher than 100%
reduces or increases the selected items
respectively.

4. Click the Scale button on the toolbar or press
the Enter key.
To undo the last scale, click the undo button.
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A The Proportional checkbox applies equal
scaling to the selection’s width and height.

B The Width and Height fields let you apply
separate horizontal and vertical scaling.
Items can be scaled by a percentage of the
items current size or by entering new
measurement dimensions.

C The Set pop-up menu displays the available
sets of scaling option configurations.
Multiple groups of scaling selections can be
created, stored, and selected as needed.

D The QX-Scaler toolbar offers scale,
interactive scale, and undo scale buttons
and quick access to several standard
scaling percentages from 25% to 200%.

E The Grow box lets you to resize the palette.

F The Command pop-up menu offers menu
access to the same commands as the
QX-Scaler toolbar. In addition, options for
customizing the palette size are also
available.

QX-SCALER

B

C

F

QX-TIPS & TRICKS

A The Tip window displays the QuarkXPress
tips.

B The Display tips at startup checkbox
displays a new tip each time QuarkXPress
is opened.

C The Next Tip button enables you to view
several tips at a time. Clicking this button
displays the next tip in the series.

D The More Tips button brings up a dialog
which displays tips by their subject
matter. This dialog also offers a Find field
so you can search for tips by topic.

E The Display tips at shutdown checkbox
displays a new tip each time QuarkXPress
is shutdown.

Offers hundreds of timesaving tips—written by
David Blatner, author of QuarkXPress Tips and
Tricks—for experts and novices alike.

To open QX-Tips & Tricks:
1. Choose QX-Tips & Tricks from the Utilities

menu.
To view the next tip, click the Next Tip button.

To search for tips by topic:
1. Open the QX-Tips & Tricks dialog box.
2. Click the More Tips button to view tips by topic.
3. Type the topic you wish to search in the “Find”

field.
4. Click the Find button.
5. Select a tip title and click View to read the tip.
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Print spot colors as process colors, save a region
of your page as an EPS file, print discontinuous
pages and print multiple plates.

To save a region as an EPS file:
1. Click the Save as EPS button from a toolbar.

The cursor appears as a crosshair pointer.
2. Draw a rectangle around the area you want to

save as an EPS file.
3. Choose Save Selection as EPS from the File

menu.
Specify the name, scaling, type of EPS file,
data format and OPI settings for the EPS file.

To save a selected object:
1. Select an object.
2. Choose Save Item Bounds as EPS from the File

menu.
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A The Print Range field allows you to

enter discontinuous page numbers
and page ranges in any order.

B The Print Spot Colors as Process
Colors checkbox temporarily
converts spot colors to process
colors. After printing, the colors are
converted back to spot colors.

C The Print Multiple Plates feature
allows you to print multiple plates
and select only the plates you want
to print. Simply hold down to Shift
key while selecting plate colors from
the Plates pop-up menu.

D The Switch Modifier feature offers a
user-defined hot key that can switch
between the Print and Page Setup
dialog box while saving your settings.

QX-PRINT
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